
Humanities-Ebooks: Insights Authors’ Handbook 

1. Introduction: Insights Style and Guidelines 

1.1 General Guidelines 

Guidelines for each category of Insights can be found online in a 

separate web page for each category by following this link:  

http://www.humanities-ebooks.co.uk/humanities-insights.html 

 

Please remember that your Insight will be used by college and high 

school students in many cultures, and that many tutors will penalize 

students for using inappropriate registers, sentence fragments, 

incomplete references, and casual use of conventions which have 

specific meanings … such as the incorrectly used ellipsis in this 

sentence. Your work should be lively and readable by non-

specialists—you should avoid unexplained jargon, knowing 

allusiveness, or Jamesian obliquity [such as ‘Jamesian obliquity’]—

but you should write in complete sentences, present quotations in 

correct style, indent paragraphs conventionally, and punctuate 

punctiliously. Please avoid starting ‘sentences’ with co-ordinating 

conjunctions (e.g. Because), or using any register or degree of 

informality that you would not expect to find in a dissertation.  

1.2 MHRA Style 

For all aspects of usage not covered in this document we recommend 

that authors go to the MHRA site and download a free copy of their 

current Style Guide: 

 

http://www.mhra.org.uk/Publications/Books/StyleGuide/download.sh

tml 

 

http://www.humanities-ebooks.co.uk/humanities-insights.html
http://www.mhra.org.uk/Publications/Books/StyleGuide/download.shtml
http://www.mhra.org.uk/Publications/Books/StyleGuide/download.shtml


 

 

 

2 

1.3 Preparing your ‘typescript’ 

Your contract with Humanities-Ebooks requires that your book is 

submitted in a file template provided by the publisher, and that all 

typographical layout and usage conform to the HEB style sheet or the 

MHRA style sheet. The ‘default assumption’ is that with the 

exception of the processes listed below, your file should be ready for 

conversion and publication when sent to the General Editor or the 

publisher.  

 If you are used to CRC standards of presentation (camera ready 

copy) or have good IT skills this should not present any difficulties. 

If not, you may want to ask an IT-proficient secretary to make sure 

that the requirements of the template and of this checklist have been 

applied consistently.  

 The process for handling your typescript is as follows. If it 

belongs to a series it should be sent in the first instance to the 

relevant General Editor of the Insights or the Monograph series who 

may suggest some modification of content or presentation, or query 

any departures from House Style. You should check with your Editor 

whether a print out is required.  

 When any editorial changes have been dealt with to the mutual 

satisfaction of author and editor, the file will be forwarded to the 

publisher for production. 

 The publisher will then perform these tasks: 

 

 a final check for consistent layout (such as identical ‘drops’ 

to chapter headings) 

 fine-tuning of typography to deal with problematic page 

endings (such as widows and orphans) or excessive word 

spacing requiring hyphenation 

 a check that all chapter and main section headings are in the 

styles (Header 1 and Header 2) that are automatically 

‘bookmarked’ and included in the table of contents) 

 final sizing and placing of any images 

 optimization of the appearance of any tables 

 conversion to PDF 

 addition of a ‘cover’ and copyright page with ISBN  
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 provision and editing of bookmarks (for navigation) 

 styling and activation of internal hyperlinks 

 setting the opening defaults, page transition rules for the 

Ebook 

 setting permissions (limiting what the reader is allowed to do 

with your book) and applying encryption 

 

Otherwise it is your responsibility to ensure that all aspects of your 

book are in conformity with (a) the rest of this Handbook (which 

contains precise guidance on variant spellings, abbreviations, 

punctuation, typographical conventions and so forth), (b) the Insights 

Template (see 2.1 below), and (c), for other aspects of usage, MHRA 

style. 

Typescripts which do not conform to the Template and the Style 

Sheet may be returned to the Author or corrected at the Author’s 

expense, at the discretion of the General Editor or the Publisher, any 

such charges being set against the author’s eventual income. To avoid 

this eventuality, please carry out the checks advised in Part 10 of this 

Handbook, or engage someone with appropriate computer skills to 

perform them. 

Better still, please cultivate the typing habits outlined in Part 2. 

1.4 Proof-reading 

Once your book has been received and edited in Word it will be 

converted to an InDesign CS4 or CS5 file, with superior typography, 

and exported as a pdf proof.. You will be ask to proof-read the Pdf 

and return a list of corrections in a Word file (there is no point trying 

to correct the pdf itself as this will be discarded).  

The corrected InDesign file will then be used to generate up to 

four different versions: the master file from which the Pdf ebook 

will be generated; a second file with a different front end, for 

conversion to Kindle, a third version (if requested) for a paperback 

version, and a fourth version (if this seems viable) for conversion to 

ePub. See note at the end of this Handbook.  
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2. Word-processing your book 

2.1 The Template 

Your book must be submitted using the latest Humanities Insights 

Word Template which is available from Richard Gravil.  

This template includes a number of specified styles, which 

incorporate appropriate font sizes, indents and line spaces (except for 

the line spaces these are illustrated below.) Do not use any other 

styles in your document. To avoid importing styles when pasting in 

from another document, use the command ‘paste special’ rather than 

‘paste’ and select ‘text only’. To apply the styles go to the Format 

menu; select ‘Styles and Formatting’; and in the right hand column 

select ‘available styles’. In Office 2010 select ‘Change Styles’. After 

that, the style box in your toolbar should show only the twelve 

recommended styles in the template.  

2.2 Pre-emptive typing habits 

Because the template can easily become contaminated by importing 

styles along with pasted text it is best to type your work from scratch 

in the Word Template, with the Styles and Formatting menu open at 

‘Available Styles’. And keep the following points in mind: 

 

1. Headings in the template include their own line spacing. You 

should not need to insert any line spaces /carriage returns at 

all, except for stanza breaks in poetry quotations.  

2. At the end of a chapter please use a page break command 

(CTRL+Enter). 

3. NEVER use the space bar for any kind of formatting. As 

all extraneous spaces (that is other than a single space 

between words and a single space after a full stop) will be 

removed as the first step in preparing the final book, any 

layout achieved by using spaces will disappear. 

4. All text in your Ebook should be in Normal or Normal First  

style unless it is a header, a hyperlink, a quotation, a footnote, 

or part of a bibliography. 
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5. Most authors will need to use a tab in one circumstance only: 

after the numerical reference in a footnote. Kindle and ePub 

conversions do not recognise tabs. 

6. For numbered, bulleted or lettered lists please use the 

automatic word facility (within normal style or prose 

quotation style, q.v.) to ensure that they are all in the same 

layout. But DO NOT use automatic numbering for 

numbered headings. 
7. Always use the appropriate quotation style (prose quotation, 

poetry quotation or free verse) for any quotation that is not 

run-on within your text. These styles provide the correct 

indent and type size. Do not add extra line spaces between 

paragraphs or before and after quotation blocks (except 

between stanzas in quoted poetry). Despite their names, 

poetry quotation and free verse may be useful in other 

contexts. 

8. Use only one space after a full stop / period. And never type a 

full stop without a space, for instance in names like W. H. 

Auden or W. G. Collingwood. [It is of course desirable to use 

hard spaces in such cases].  

9. Never use the space bar or tabs for paragraph indents. 

10. In poetry layouts: use en and em spaces for complicated 

patterns of indents (Insert > Symbols > Special Characters) 

rather than the space bar or tabs.  

2.3 Tables 

If your book requires complicated layout for items such as 

chronologies, please make sure that these are presented using tables 

(with as many columns and rows as you need) not tabs or spaces. If 

you are not familiar with constructing tables it would be helpful if 

you could send a sample to the Publisher at an early date so that he 

can provide you with a format to use.  See also section 2.2. 

2.4 Headings and Sub-heading 

Do not type headings entirely in capitals or include any punctuation 
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(other a question mark) at the end of headings. The first line of a text 

or after a sub-head is never indented. Sub-heads are a useful aid to 

navigation in electronic format and they appear as bookmarks in the 

navigation panel of the final product. For that reason, please try to 

avoid sections without headings, or with just numerals. And please 

use Heading 1 and Heading 2 only for headings that are to appear in 

the navigation panel. You should number chapter headings, and may 

number sub-heads if you choose, as this helps to achieve clarity in the 

Bookmarking of your document (i.e. the electronic index).  

2.5  Page numbers and running heads 

The template provides page numbers. You do not need to add one. 

Text for Humanities Insights should be submitted as one file, with a 

simple running head: (e.g. Literature Insights: Mary Barton).  

2.6  References 

Your work must be fully referenced, but please remember that you 

are writing for students and it follows that what you write should 

need less referencing (and should involve less reliance on secondary 

sources) than a scholarly article. Please use MHRA referencing style 

for History Insights. You may use MHRA or MLA for Literature 

Insights, and should use Harvard for Philosophy Insights. If using 

MLA style the list of works cited will be bookmarked but please 

make sure that your parenthetical references always include page 

numbers. If using MHRA, please make use of short, unambiguous 

parenthetical references wherever practicable for successive 

references to the same work, to avoid cluttering the page with 

footnotes. Footnotes should be used very sparingly in Insights titles. 

All footnotes must be electronically embedded as illustrated below.
1
   

                                                 

1  To insert a footnote go: Insert > References > Footnote. Select ‘Bottom of 

Page’, ‘Format 1, 2, 3’, and ‘Numbering restarts each page’.  
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2.7  Languages other than English 

Quotations in foreign languages must be accompanied by translations 

(in parentheses) and non-Latin characters must be transliterated.  

2.8  Typefaces and Colour 

BLOCK CAPITALS, SMALL CAPITALS (where they appear in 

antiquarian quotations), italic, and bold should be employed where 

required. Do not use traditional instructions to printers, such as 

underlining to indicate italics. In Insights titles you may find it useful 

to use dark blue (the heading colour) to pick out poem or chapter 

titles where they occur in your text.  

2.9  Illustration  

You are welcome to find appropriate visual enhancements for your 

text, provided that copyright clearance has been obtained and, if need 

be, paid for. Pictures should be in the form of modestly sized jpeg 

files. It is easy to downsize images to about 100–150k by using a 

picture editor so that the image opens to the size required – e.g. a 

quarter or a half page. In the case of artworks it may be that someone 

reading on a larger device would appreciate higher resolution. Please 

supply these as separate files and send as attachments, rather pasting 

into an email. You can, of course, include hyperlinks to online audio 

or video resources.   

2.10  Cross-References 

Cross-references should be avoided, but any essential ones should be 

to section numbers, not page numbers. 
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3. Hyperlinks, Tables, Lists and Bibliographies 

3.1 Hyperlinks 

Internal Hyperlinks 

Early Humanities-Ebooks titles contained internal hyperlinks. These 

are not really viable now that we are producing for print, pdf and 

ePub versions. Where authors wish to gloss a remark with further 

information, of a few lines, or provide extensive background 

materials there are four options:  

 

(a) use the ‘Examples’ style to set off the comment in a different font 

and colour from your main text, so that it looks like an interjection.  

 

(b) use footnotes to gloss unusual terms or provide brief biographical 

or historical information. In the Pdf or any print version these will 

appear at the foot of the page. In Kindle versions they will probably 

be clustered at the end of a chapter and it is fairly easy for the reader 

to navigate to and back from footnotes. But it is prohibitively 

expensive to convert heavily footnoted books to ePub.  

 

(c) place the information in a simple one-cell table 

 

(d) use Appendices for longer items. These will be bookmarked in 

the Pdf and of course included in the t.o.c. of Kindle and print 

versions.  

External Hyperlinks 

If you copy a URL from your browser, or type and activate it by 

clicking ‘enter’ it should appear automatically in hyperlink style and 

function properly, even after conversion to PDF. Remember that 

although it is possible in an eBook for most of the URL to be hidden 

behind a hyperlinked phrase, for print purposes it is necessary for the 

full URL to be shown. Try to avoid placing hyperlinks in footnotes 

(this creates serious problems when the InDesign file is created) or 
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typing full URLs into continuous text as this is likely to create 

problems of layout. You can insert external hyperlinks through your 

document if you wish, or you can collect them as part of your 

bibliography. If the URL breaks across a line it may cease to function 

when converted into PDF, and if it doesn’t break it may throw out the 

line spacing. To avoid this problem, you can compose your text so as 

to introduce the URL or URLs centred on a separate line or lines, as 

for a quotation, e.g. For the Somme offensive, see: 

 

http://www.geocities.com/Athens/Acropolis/2354/somme.html 

 

3.2 Tables 

If your book requires complicated layout for items such as 

chronologies, please make sure that these are presented using tables 

(with as many columns and rows as you need). Do not use tabs or 

spaces. Please alert your editor if you have some complicated layout 

requirements so that we can provide a layout before your draft is 

finished.  

An example suitable for a Chronology is shown below. To create 

this table, go Table > Insert Table > Three columns + three rows > 

Autofit to contents:  

 

1904 February Event 

 March  

1911   

 

The publisher will then apply a prettier style to your tables, for 

instance: 

 

Year Month Event 

1904 February beginning of war of Jenkins’s Ear 

 March End of War of Jenkins’s Ear. 

1911   

 

http://www.geocities.com/Athens/Acropolis/2354/somme.html
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Please punctuate consistently within lists or tables. If some entries 

begin with capitals (for other than proper names) all should begin 

with capitals. If some end with a punctuation mark they should all 

end with a punctuation mark. Note the multiple errors highlighted in 

the example above. Punctuation should not be necessary, unless your 

entries include more than one sentence. 

3.3 Lists 

Please use the Word toolbar to create numbered or bulleted lists, so 

that formatting of successive lists will be consistent. If you wish to 

use punctuation in lists (again this is not usually necessary), please 

ensure that punctuation is consistent.  Contrariwise, please make sure 

the numbered headers are typed rather than autoformatted (it is easy 

to end up with a mixture of typed and autoformatted numbers, some 

of which may disappear when your book is threaded through another 

program). 

3.4 Bibliographies / Reading Lists 

Please use either MHRA or MLA style for bibliographies and ensure 

that all entries contain the same information (author, title, place of 

publication, publisher, date). 

 

MHRA style is essentially punctuated as one sentence and uses 

parentheses: 

 

Dessen, Alan C., ed., Essays on Dramatic Technique, 2nd edition, 

revised (Evanston: Northwestern University Press, 1981). 

MLA style is essentially punctuated as three or four sentences (with a 

fourth sentence for details of the edition where applicable) and 

without parentheses: 

 

Dessen, Alan C., ed. Essays on Dramatic Technique. 2nd edn, 

revised. Evanston: Northwestern University Press, 1981. 
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The preferred abbreviation for edited by is ed., not (Ed.), and 

certainly not ‘ed. by’ and that for edition is edn without a period as 

in: 2nd edn (Cambridge: Cambridge University Press, 1973).  

4. Spelling 

4.1 Variant Spelling 

For Humanities Insights the language used is British English. British 

spelling should be as given in the OED and the MHRA style sheet. 

For words ending in -ise or -ize please use the -ize form except where 

derivation requires -ise (e.g. advertise, advise, apprise, chastise, 

comprise, compromise, demise, despise, devise, enterprise, excise, 

exercise, franchise, improvise, incise, premise, revise, supervise, 

surmise, surprise).  

4.2 Quotations 

The spelling of quotations is always that of the book or edition 

referred to. Please follow MHRA practice for modernization. 

4.3 The Possessive 

Use the apostrophe + s for the possessive of proper names ending in 

s, z or us and French names ending in an unpronounced s, x, or z: 

Alvarez's, Cervantes's, Dickens's, Jones's, Keats's, Thomas's, 

Claudius's, Camus’s, Herodotus's, Jesus's, Darius's, Rabelais's, 

Descartes's, Malraux's, Ramuz's. For 'Moses' and Greek names 

ending in ‘-es’ use an apostrophe alone: Moses', Demosthenes', 

Sophocles', Xerxes'. 

4.4 Slavonic Names 

Russian and other Slavonic names should be given in the form 

recommended by the Oxford Writers' Dictionary, e.g. Dostoevsky, 

Shostakovich, Tolstoy, Yevtushenko, Tchaikovsky, Chekhov, Gogol, 
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Gorky, Ilya. 

 

For Accents, Hyphenation, Place-Names, Personal Names (including 

classical names, popes, saints, foreign kings and queens, etc.) please 

see the MHRA Style Sheet.  

5. Abbreviations 

5.1 General 

Never begin a sentence or a footnote with an abbreviation, and avoid 

abbreviations as far as possible in passages of continuous prose 

(terms like page and line should be spelt out, other than in 

parenthetical references). Extensively used abbreviations should be 

clearly listed at the beginning of your book.  

5.2 Titles 

Abbreviated titles should normally take the form of a short title, not 

initials: use Ordeal, not TOGF, for The Ordeal of Gilbert Feverel.  

5.3 In Footnotes 

Avoid beginning a note with 'e.g.', 'i.e.', or 'pp.' which must always 

remain in lower case. Write out ‘For example,’ ‘That is,’ or ‘Pages’.  

5.4 Use of Full Stop 

Contractions ending with the same letter as the full form, including 

plurals (e.g. Mr, Dr, Mrs, Ms, Mme, St, vols, nos [ numbers]), edn 

[edition], 2nd, do not need a full stop. Abbreviations, such as M. 

[Monsieur], p., pp., a.m., vol., and no. [number], do. 

 Standard works of reference and journals known by their 

initials—OED, DNB, MLR, PMLA, TLS, EETS, ANTS—do not need 

stops. Nor do MS or MSS (for manuscripts) or countries and 

organizations: USA, USSR, UK, BM,BL, PRO, MHRA, UNESCO  
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5.5 Common abbreviations 

Follow MHRA style for such words as bus, phone, the twenties (i.e. 

1920s). 

5.6  American States 

Use the postal abbreviation: e.g. CA, MA, MO, ND, FL.  

6. Punctuation, Capitals, Italics, etc 

6.1 Abutted EN and EM Dashes 

Do not use hyphens when expressing page spans, date spans, or place 

spans. The short dash ('en rule': which you will find in Word by 

going Insert>Symbol>Special Characters) is used in such expressions 

as the England–Australia test match; the London–Leeds motorway; 

the 1939–45 war; pp. 81–101. [not London-Leeds, 1939-45, 81-101]. 

 Long dashes—'em rules'—may be used, as here, for parenthetical 

statements or to denote a break in a sentence—but commas, colons, 

or parentheses are often more appropriate. If you wish, you may 

preserve the old-fashioned alternative – like this – (i.e. space, en-

dash, space) in quoted matter.  

 Use a double em dash (——) followed by a stop and space to 

indicate 'ditto' in bibliographies and similar lists, where authors’ 

names apply to more than one work: 

 

Williams, Raymond. Culture and Society … 

——. The Long Revolution … 

6.2 Parentheses and Brackets 

If one parenthetical statement lies within another, use brackets within 

parentheses, as in (His presidential address [1967] made this point 

clearly.)  

 The place of publication and date may be enclosed in brackets, 
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when the rest of a footnote citation appears in parentheses: (John 

Jones, Autobiography [Boston, MA: 1910], 233–45).  

 Brackets should also be used [as here] for interpolations.  

6.3 Punctuation in Headings 

Punctuation marks (other than “?”) should be omitted at the end of 

headings and subheadings, or after items in lists. 

6.4 Punctuation with Italics 

Only italicise punctuation marks when they form part of a title. Who 

wrote Conrad's Typhoon? But who wrote Westward Ho! ? 

6.5 Ellipses 

For quoted points in an original text, in such writers as Whitman, 

please use spaced stops: . . . but with a hard (non-breaking) space 

between each stop [usually CTRL+Shift+space]. 

 For quoted ellipses use an ellipsis from the Word ‘Insert’ menu 

(special characters): … 

 To indicate that you have omitted material from a quotation, 

please use an ellipsis within brackets […] and preserve the original 

punctuation.  

 In shortened quotations there is no need to bracket any change you 

make to an initial letter (capital to lower case or vice versa). 

 It is not customary to use an ellipsis at either the beginning or the 

end of a quotation.  

 

For Quotation Marks and Exclamation Marks please see the MHRA 

Style Sheet.  

6.6 Capitals 

Consult the MHRA style sheet regarding initial capitals in the names 

of places, persons, months, days, and nationalities; the titles of laws, 

plans, wars, treaties, legal cases, and institutions; unique events and 

periods; the parts of books when referred to specifically (Chapter 9, 
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Part 1); the points of the compass, when used to indicate a specific 

area (the North of England), a political concept (the West), or as part 

of an official name; titles of dignitaries; sobriquets (the Iron Duke); 

the names of periods or movements derived from proper names; book 

titles in different languages; and accented capitals. 

6.7 Italics 

In general follow the advice in the MHRA style sheet. Avoid 

excessive use of italics for emphasis. Do not italicize such thoroughly 

adopted foreign words as dilettante, cliché, debris, résumé, or 

abbreviations (other than sic). Do italicize titles of films, named 

pieces of music or paintings (Swan Lake, The Haywain) and book 

titles, other than ‘the Bible', 'the Koran', and 'the Talmud', and books 

of the Bible. The titles of poems, songs, essays, unpublished theses, 

and chapters in books should normally be in roman type enclosed 

within single quotation marks. Authors of independent monographs 

may choose to italicize poem titles if they prefer this practice. Titles 

of other works which appear within an italicized title should be 

printed in italics and enclosed within single quotation marks: e.g. 

Essays on ‘Under the Volcano’ 

6.8 Dates 

Dates should be given in the form ‘Friday, 23 April 1564’. The name 

of the month should always appear in full between the day (‘23’ not 

‘23rd’) and the year.  

 

For periods, centuries, eras, decades, numbers, dates (e.g. 1792–

1750 BC), roman numerals, currency, weights and measures, see 

MHRA. 
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7. Quotations 

Short quotations should be enclosed in single quotation marks and 

run on with the main text. Line divisions in verse should be divided 

by a spaced forward slash ( / ) (with a space either side of the slash). 

A series of short quotations may be indented as for long quotations. 

For a quotation within a quotation, double quotation marks should be 

used. Long quotations (prose quotations of more than about forty 

words of prose, or consisting of more than one paragraph, and verse 

quotations of more than two lines) should be indented using the 

appropriate Template style (Prose Quotation, Poetry Quotation or 

Free Verse).  

7.1 Punctuation of quotations 

If a short quotation is used to end a sentence, the final full stop 

should be outside the closing quotation mark unless the quotation is 

both a complete sentence and preceded by a punctuation mark, as it is 

in: ‘Her parting shot was, “Well, I hope you both enjoy yourselves.’” 

Any comma or semi-colon that forms part of your sentence, and 

is not in the quoted matter, should also be outside the quotation mark: 

‘The gloom’, he responded, ‘has deepened.’ BUT ‘The gloom, in my 

opinion,’ he responded, ‘has deepened.’ 

 The first line of a prose quotation is not normally indented, unless 

it is a line of dialogue. Verse quotations should follow the lineation 

and indentation of the original (the en space and em space are useful 

for this). For all such quotations the appropriate style in the 

Humanities Ebooks Template should be used. Please supply a 

photocopy of any poetry quotation involving a complex pattern of 

indentations.  

Long quotations should normally end with a full point unless the 

original has a question mark or exclamation mark. The initial letter of 

the first word of a quotation should be changed to or from a capital if 

this is more appropriate in the context. It is not necessary to bracket 

such changes. 
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7.2 Parenthetical references 

In run-on quotations the final punctuation follows the closing 

parenthesis: ‘… utter humiliation’ (Book 6, Chapter 52). In indented 

quotations, a parenthetical reference is placed outside the closing full 

point, and requires no punctuation.  

utter humiliation. (Book 6, Chapter 52)  

7.3 Omissions 

Omissions within prose quotations should be marked by an ellipsis 

within brackets […] using the ellipsis symbol in the Insert menu, 

NOT separate stops: (Go <Insert><Symbol><Special Characters>). 

Omitted lines of verse should be marked by an ellipsis, also within 

brackets, on a separate line. Ellipses are not used at the beginning or 

end of a quotation.   

 

For layout of quotations from plays see the MHRA Style Sheet.  

7.4 References 

Where possible please use the modern form of reference to primary 

works, in Arabic numerals only. It is now commonly understood that 

Hamlet 3.2.45 means Act 3, Scene 2, line 45; or that Prelude 10.234–

45 means book 10 lines 234 to 45; or that CL 2: 435n means 

Collected Letters, volume 2, page 235, note. Use of p. or pp. in 

references is superfluous: Smith, 134 is highly unlikely to mean 

anything other than Smith, page 134. 

8. Copyright and Permissions 

It is the responsibility of an author to obtain permission for the 

quotation of any copyright material if such permission is necessary 

(see Permissions, below). Copyright in a literary, dramatic, musical 

or artistic work (including a photograph or a translation) lasts until 70 
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years after the death of the author and may last longer if steps have 

been taken to extend copyright.  

 

A useful but incomplete copyright search engine (for instance, you 

will find Max Beerbohm but not Geoffrey Hill) is maintained by the 

Harry Ransom Research Center and Reading University Library at 

http://tyler.hrc.utexas.edu/ 

 

Since you are publishing online it is necessary to acquire world 

rights, and where American publishers are concerned any quotation 

from a poem that is still in copyright requires permission and may 

involve reproduction fees. Complete items such as tables, 

illustrations, and poems or consecutive lines from poems, if still in 

copyright, must not be reproduced without permission. 

8.1. Permissions 

The Fair Dealing Clause of the Copyright Act specifies that, within 

limits, quotations in a critical work may be reproduced free-of-

charge, and without the permission of the copyright-holder, if they 

are directly criticized or commented upon. The Society of Authors 

advises that “the provisions of fair dealing for criticism or review 

may only be applied to quotations reproduced in order to illustrate 

comments about the literary work itself. Fair dealing does not cover 

the quotation of material in order to comment on the author, or, in 

the case of biographies, the subject.” It is important to keep an eye on 

the length and importance of the quotations, the ratio of quotation to 

commentary, and to ask yourself whether your quotations are, as the 

Society puts, it, there to save you work. The following quotation is 

probably not fair dealing, but I make the assumption that my 

transgression is for the public good: 

“Some years ago The Society of Authors and the Publishers 

Association stated that they would usually regard as fair 

dealing the use of: 

 

a single extract of up to 400 words or a series of extracts 

http://tyler.hrc.utexas.edu/
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(of which none exceeds 300 words) to a total of 800 

words from a prose work 

or extracts to a total of 40 lines from a poem, provided 

that this did not exceed a quarter of the poem 

 

The words MUST be quoted in the context of criticism or 

review. 

 

NOTE: While this statement does not have the force of law, it 

carried considerable weight with a judge experienced in 

copyright in a leading infringement case. It does not mean, 

however, that a quotation for purposes of criticism or review in 

excess of these limits cannot rank as fair dealing in some 

circumstances” 

If Mary Barton were in copyright, which of course it isn’t, the 

following passage in my Literature Insight would not count as fair 

dealing: 

One of Barton’s strongest speeches enunciates a labour theory 

of value:

“You’ll say, (at least many a one does) that they’n getten 

capital an’ we’n getten none. I say, our labour’s our 

capital, and we ought to draw interest on that. They get 

interest on their capital somehow a’ this time, while ourn is 

lying idle, else how could they all live as they do?” 

And to Wilson’s predictable objection (on behalf of the 

middle-class reader) that the masters suffer too, Barton replies 

reasonably enough, ‘Han they ever seen a child o’ their’n die 

for want of food?’  

But unless I delude myself, the following would: 

The very next paragraph tells us why John Barton was among 

these ‘earnest men’ who remember their wrongs. His mother 

had died in poverty. As a good workman he was pretty certain 
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of steady employment but: ‘he spent what he got with the 

confidence (you may also call it improvidence) of one who was 

willing, and believed himself able, to supply all his want by his 

own exertions.’ Parentheses in the novel, as here, often signal a 

reading instruction (Jane Austen and Dickens use the same 

technique). In Gaskell’s case, they imply unease, and draw 

attention to a process of negotiation. The quotation could be 

describing the confidence of a self-reliant man, not a wastrel, 

yet she now permits the reader—‘(you)’—to call his generous 

behaviour ‘improvidence’. If this were an isolated case, it 

would be insignificant. But the strategy of this novel, 

repeatedly, is to establish a point of maximum identification 

with John Barton before testing the relevance of a middle-class 

cliché such as ‘improvidence’.  

8.2 Conclusion 

Authors of Humanities Insights on copyright novels should avoid 

using quotations where paraphrase would do just as well, and should 

ensure that the ratio of directly pertinent critical comment to quoted 

matter is at least 2:1. Provided that you follow these guidelines you 

may use a series of extracts from a novel (of which none exceeds 300 

words) up to a total of 800 words, without permission. With poetry, 

one must be more cautious. For in-copyright poets it is necessary to 

assume that the reader has a copy of the poem open, so that it is never 

necessary to quote more than 25% of any poem or more than 40 

complete lines, in total, from the oeuvre.  

9. Debugging Your Typescript 

As explained in Part 1, the Humanities-Ebooks profit-sharing 

mechanism is based on the assumption that your ‘typescript’ will be 

presented in a form that is almost ready for conversion into PDF. 

Only the steps specified in 1.3 above will be performed in house. 

Any extensive correction required may be charged to authors (with 

sums being set against earnings). To avoid such problems please 
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observe the following sections.  

9.1 Check the Template Styles 

When your have finished drafting your book you should compare the 

appearance with any sample that is already available online and 

check the status of styles within your document.  

To check your document, open Format>Styles and Formatting and 

click on Show ‘Available Styles’. If more than fourteen styles are 

listed you may need to delete those that should not be there, and go 

through your document re-applying the correct styles as illustrated at 

the start of the Template. If any of your Normal or Prose Quotation 

text is left aligned rather than justified, or if the margins have 

changed, the style may have become corrupt and you may need to 

redefine (as well as reapply) the formatting. The easiest way to deal 

with corruption of Normal style is to select all your text and paste it 

in to a new copy of the template file. 

Then (with ‘Available Styles’ visible)  

 

1. Make sure that all your text (other than bulleted lists, 

numbered lists, or tables) is in Normal or Normal First style, 

and that all your quotations are in Normal, Prose Quotation, 

Poetry Quotation, Free Verse or Example.  

2. Make sure that your footnotes are in the correct font [Arial 9], 

justified, and with a hanging indent. Only the reference 

numeral should be in Footnote Reference style (blue and 

bold superscript). The text should be in Footnote Text style 

(Arial 9). Insert a tab after the numeral, so that your footnotes 

look like the one below.
1
 

3. Make sure that all headers are Heading 1, Heading 2 or 

                                                 

1
  In footnotes the numeral (which should appear automatically in Footnote 

Reference style) is superscript and emboldened. The Footnote Text style is Arial 
12 point regular. Using a tab after the reference numeral ensures that all text is 
neatly aligned.  



 

 

 

22 

Heading 3 [blue and Times New Roman]. 

4. Make sure that you have applied Bibliography style to your 

Bibliography. This has a hanging indent and a line space ). 

5. Check that any anchor phrases for hyperlinks are in hyperlink 

style (see below for submission of hyperlink materials). 

 

Next, please go through the following processes to weed out drafting 

errors and typographical inconsistencies. 

9.2 Find and replace (where applicable) 

1. Use find and replace [edit>replace] to replace all single 

quotation marks ‘ and all double quotation marks “ (this will 

ensure that they are all in the same style—Word often mixes 

quotation mark styles). Then check for any initial apostrophes 

that have been changed by this process, e.g. from ’mid to 

‘mid.  

2. Use find and replace to change all hyphens to en-dashes 

except in hyphenated words. You must use en-dashes for 

page references or date spans such as 23–24 or 1914–18, and 

em-dashes—without spaces—for parentheses or sentence 

breaks [Insert>Symbol>Special Characters]. To ensure that 

that you do not change legitimate hyphens, do not choose 

‘replace all’; go through systematically, and for each instance 

choose ‘replace’ or ‘find next’. 

3. Use find and replace to ensure that there are no double spaces 

(in correct typographical practice a full stop is followed by 

ONE space) anywhere in your document [replace space / 

space by space] or double commas or full stops.  

4. Use find and replace to replace any punctuation marks 

preceded by a space [ , . ; : ?] by the punctuation mark alone. 

It is easier to see what you are doing if you use the ‘show’ 

command (the ¶ sign in your toolbar). 

5. Ellipses. Use find and replace to replace three stops or spaced 

stops by the ellipsis symbol … [Insert>Symbols>Special 

Characters]. Add a fourth stop if you need one because the 

omission included a full stop [n.b. the ellipsis symbol should 
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have a space either side]. 

6. Use find and replace to remove any comma before a 

parenthesis, (as here). To do this, type the symbols for 

comma/space/openparenthesis in the Find box, and 

space/openparenthesis’ in the Replace box. 

9.3 Visual Checks  

First, activate the ‘show’ tool [i.e. click on ¶ in your tool-bar], so that 

you can see the hidden typography. Then: 

 

1. Remove any spaces at the start of lines or headings, or any 

punctuation at the end of headings, or spaces between 

parentheses and what they enclose. 

2. Check that your space bar has not been used for paragraph 

indents or layout in quotations or anywhere else (layout 

within quotations should be achieved by using en and em 

spaces, available within the Insert>Symbol>Special 

Characters menu [these spaces are the width of one character 

or two characters and give you maximum flexibility for 

complex verse layouts]. 

3. Check that there are no line spaces anywhere in your 

document other than those before and after verse quotation-

blocks. Appropriate line spaces are incorporated in the prose 

quotation style and all the Header styles.  

4. Remove any line spaces between paragraphs, and check that 

the first line of each new paragraph [other than the first in a 

new section] is indented. 

5. Check that any numbered or bulleted lists are consistent in 

layout (please use the automatic layout in your toolbar rather 

than typing in the numbers), and consistently punctuated, and 

that any implied grammar is also consistent. 

6. Check that any complex layout involving columns has been 

achieved by use of tables [which are easy to adjust in-house], 

not by tabs and spaces [which aren’t]. 
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9.4 Corrections 

1. Run a spell-check (within limits, spell-checks are quite good 

at finding typos) 

2. Check that you have italicized titles, but not punctuation 

marks (unless they are part of a title) or page numbers. 

3. Ensure that your sentences end with a full stop. 

4. Consider any grammar queried by your program. 

5. Amend any sentence fragments. 

6. Rectify any drafting short-hand, such as abbreviations, initials 

for names, or informal punctuation. 

7. Ensure that you have not underlined any spaces (except 

within underlined phrases). 

8. Check that your bibliography is consistent with MLA style or 

MHRA style and that your punctuation is consistent. The 

abbreviation for ‘editor’ or ‘edited by’ is ed. [without capitals 

or brackets]. That for edition is edn [without a period]. Do not 

abbreviate such publishers as OUP. 

9.5 Hyperlinks 

If using links to museums or art galleries please ensure that you have 

followed follow their instructions as regards acknowledging the 

institution, as well as providing the URL. Please test your hyperlinks 

to see that they are ‘live’.  

10. What to Send 

10.1  The File Itself 

Please make sure that your final file includes as its first three items: 

 

1. a Note on the Author (at the start of your document) 

2. any required Acknowledgements  

3. a Table of Contents (this will be replaced by an electronically 

generated one, but yours will be used to check the automatic 
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one) 

10.2  Addenda 

Please include, as non-printing addenda, the following: 

 

1. copies of all permissions for use of copyright material (with 

but separate from your document) 

2. a one-page blurb for your book, including keywords [see 

below] 

10.3  The Blurb 

When a potential purchaser clicks on the name or thumbnail of your 

book, s/he will be taken first to a one page description of the book, 

which should be designed to persuade the browser to buy it. If your 

text is persuasive enough the potential buyer will click the familiar 

‘add to Cart’ button).   

 

The blurb should be submitted with your file, but may be emailed 

direct to the publisher before or after the book, should not exceed 280 

words, and should include: 

 

1. a one sentence statement encapsulating your Insight. 

2. either a brief table of contents or a paragraph calling attention 

to the main features of your approach (what you think makes 

your book unique or especially useful) or a combination 

thereof.  

3. in the case of poets, a list of the poems your Insight actually 

discusses.  

4. a note on yourself (which may be identical to the one in the 

book) 

5. the book’s vital statistics: e.g. word length, 5 illustrations; 

internal hyperlinks, external hyperlinks, audio clips. 

6. Up to 12 well-chosen key words (see below) 
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Hopefully, your General Editor may be able to add a sentence or two 

of any pre-publication praise the book has received from an expert 

reader – or you may be able to solicit such an endorsement yourself. 

10.4  Keywords / Metadata 

Search engines crawl the web looking for ‘metadata’, keywords that 

indicate whether your book should appear on a list of hits. Choice of 

the right keywords is vital. These words will be hidden in the 

metadata of your ‘product page’ and will be visible to search engines 

(including our own website search tool) but not visible on the page.  

 

The keywords and phrases you choose should: 

 

 include your name and the title of your book 

 be highly specific (‘Bathsheba Everdene’, or ‘The Critique of 

Pure Reason’ or ‘The Realms of the Gods’ are more likely to 

be valuable than women characters or German thought or 

Realms or Gods) 

 be words or phrases that a potential customer is likely to enter  

 and they absolutely must appear also in the description you 

have provided in the blurb (Search Engines reckon that if the 

keywords don’t match the page content something fishy is 

going on) 

 

Please provide about 12 high quality terms and separate them by 

commas. To check whether a search term is ‘high quality’, try  

searching it in Google. Generally speaking, the more hits you get, the 

more useless the search term is likely to be. In an Insight on Go 

Down, Moses and Big Woods, for instance, there is no point listing 

‘Moses’ or ‘Woods’ or ‘Bear’. ‘Yoknapatawpha County’ and ‘Delta 

Autumn’ are likely to be more useful, and ‘A Bear Hunt’, since a 

sensible searcher will also key in Faulkner. Obviously, in a book on 

Shakespeare’s Hamlet one can hardly avoid using both terms…. 
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10.5  A Cover Image 

Images do sell books. If you are able to provide a cover image (a 

photograph you have taken yourself, or which you know to be in the 

public domain, or for which you have sought and obtained 

permission) please do so. We do have a Fotolia account and once in a 

while we are able to locate royalty free images such as those on the 

cover of Catch-22, Chaga, and Laughing at the Darkness.  

10.6  Links 

We are working hard to ensure that Google and other search engines 

produce results on page one of any search, but we cannot do it 

ourselves. Perhaps the biggest single factor in deciding whether your 

book appears on page 1 or page 31 of Google results is the number of 

one-way links to Humanities-Ebooks.co.uk from other places on the 

web—e.g. from your personal website, your university web page, any 

associations you belong to, online journals, and so on.  

And finally … 

If in doubt (or if you find errors in this style sheet) please contact: 

 

richardgravil@hotmail.com 

POSTSCRIPT: ePub Conversion 

At present (September 2012) ePub files for sale through the iStore, 

Barnes & Noble and elsewhere have to be manually and expensively 

converted, and we can only do this (a) for files that seem likely to 

cover the conversion costs within twelve months (we estimate that 

Amazon accounts for about 70% of the market, so returns from the 

additional format may not be very significant), or (b) if the author is 

prepared to advance a sum to cover those costs. A 100 page Insight 

can cost between £70 and £160 to convert and distribute to the iStore 

—the variation accounted for by the number of footnotes. 

mailto:richardgravil@hotmail.com

